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AfFeifye == E
“Afsrera == 2afe Definition =1t i weEm | Wity | Equation > ARel
Aot v s eI | Ao Koo s emeiE == a1 | Epicurism > TeIm
I | (@ * =R ACHCA (@I [ g TS T4t I, | Extension > TR
w3 SifFem | Eye witness > oTRvEl

A Edition » A
Aboriginal > SR Edit_or_ . >
Amplification > AR EXh'b't'_on > et
Adjournment > Teref Enterprise > A S
ot > e ]
Anonymous > @& .
Anticipation > oo Etiquette > T;'W
Archetype > e
Atteste)c/ip > sTepifire /e Final > e
Autonomous > TreHre Filing > fegfe
Amendment > SR Forgery > wiferife

B Faculty > SqEm
Bail > wiftm File >
Background > sBef Folio »> el
Blue Print > dfefoa G
Booklet > et Gazette > TARe@
Basin > SRl Graphic > ERE
Blockade VRSN Grotesque > Tge
Bloc > =feralt Green room > SArerE
Bill b IS CER T General manager > TRRZF
Book Post > (A T Glossary > Bt

& Graduate > T
Cabinet > wfasifam Guideline > et
Cricular > sfas@ Goodwill > I
Covenant > pfea H
Coating > w=Ee Homicide > eyl
Coup > G Hostage > f&fw
Corrigendum > efeg Housing > SR
Constituency > fdioat et House Physician > R i
Custom > & Human rights > eI
goncoct ; :fg il Hydrologist > onffaeea

anvass . -

Certified > e Eggfg ¢ i bl
gz:ﬁg)g:iy ; ;@@W Hard money > TqW Bl

= Hoarder > :Y;:LEWN

S Home ministry > QG NFART
gz;fjrllgik iw%a@ Horticulture > @“?ﬁﬂﬁﬁﬂ
. Hearing >

Deputation > 2R .
Discriminatory > W Horizon > frre
Deceive > roige F41 Hydra.UIlCS > Ge W ﬁw:[
Divulge > o T4 L
Directorate > Afmea Longitude > mifes
Dividend > Fopien Lobbying > onfikE
Design » J 0 Livestock > AR
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Litigation > SIS Radiation > fafead
Lingua Franca > e o Radical > e
Liquidation > SRETEE Radioactivity > TowFETe!
Light-Year > ST Rational > yfeami/gfestere
License > el fq Referendum > oot
Lender » TR Refinery P SIERIRIE
Leftist > ATAY Refugee > Tag
Leaflet > eblaTia Rehabilitation > AT
Latitude > SFIA Resident > SRR
Landslide > griifos, @ Realism > ABIEM
Faire > SIS S
Laboratory > oRrweAR Sabotage > Swde

Q Safeguard > THEED
Quarterly > tawih Sample > A
Quack > ALY TIER Sanitation > =g IF
Quality > e Satellite > Tolag
Quantity > eff Screening > %R
Quantum > eff Scrutinizer > @
Quarters > SRR Sculpture > orFd
Queue > f Script > farfst
Quarter > vgdied Schedule > i
Quota > fdifas wee Sea level > W"!—é
QUOtation > WW"W Seaman > T{lﬁ'ﬁs
Questionnaire > e Seasonal > TS

R Secular > e
Ratio > SIS Seismography > iyl
Rotation > SRe Semicircle > wdqs
Routine > s/ e Service > Bigal
Rehearsal > WOl Spectrum > 3fife
Rent > Qe /fore! Session > S
Republic > oereg Short title > MiEm
Remittance > TeEd Soft drink > TFIE 2R
Representation > effsfafag Solar eclipse > 4 ez
Research > el Souvenir > foay
Replacement > efegiom Sovereignty > SAKCSITg
Resign > omeriel T4 Square > TAbOYS
Rewrite > oot Stipend > 3fs
Robot > WwE Sue > Tifer 41
Rule > ffg Sublet > Toreg
Range > @ Summit > AN, fore
Rack > o % Syndicate > elfefafy weera el
Radius > PIE Synonymous > INdE
Rating > fadme Search light > THEIS
Rest-house > s oam Salary > (@od
Re-union > ofAfEe Self help > T
Rector > s Solar system > GRS/ ETawes
Re-examination > AR Subscription > ol
Regiment > e Super > WK Sl
Relief > Qi Smuggler > ORIBIEN
Rural > arifa State-prisoner > SR
Race > s Strategy > A
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Subdivision > Nl Unofficial > (@RI
Superior > W Unpaid > SefTefae
Supervision > ogRYH Unauthorized > e
Survey > T Universal > Reywae, TR
Syntax > AFIAFAAd Urban > TR
Secondary > s Urbanization > e
Shorthand > At Unemployed > @FE, IR
Spy > @%bl Upper > T%
Subsidy > T Urgent > T
Subsidiary > RS Ultramodern > wfe gl
Surgeon > e Uniform > o

T Unlimited > SN
Table > Sifersst/ARat University > feifamyrera
Tabulation > Sifersl I Urinal > TR
Tally > = Unconstitutional > SRS
Telegraph > © Ultimatum > BRNq
Term > TS, W%, AW \Y,
Terminology > offfer Vacancy > Aife
True Copy > ke gfsffa Vague > g
Terrorist > TFERM! Variation > oAfaaee
Textile > Vendee > ol
Thesaurus > e =W Venue > 3N
Theocracy > ¢ Volunteer > TR
Tidal bore > ST Vacation > o
Thesis > MR Valid >
Totalitarianism > el Viva-Voce > TS AJrw
Token > o Velvet > YA
Treasury > R Vice Chancellor > T
Triangular > Tagdr/fawar Vice Versa > Redrea
Trilogy > @ W
Treaty > AEEifes e Wagon > it
Taxation > AL Waiting Room > R
Telescope > MEArEd @ Walk out > T oji
Temperature > Seal Warden > oRdl
Tariff > e Waiter > AWy AR
Teapot > BItEE Al| War Criminal > FaloRd
Trade Center > JfderEn Wastage > 975
Trade mark > Ao Watcher > 9, g=d
Top > Y Waterproof > RIS
Tourism > 45 Wealth tax > M
Transport > Afaes Whip > e
Type » Tl White paper > Teoq
Typhoon > IR wild life > Il
Translator > qEME wireless > o
Tribal > SRR Wit > afrmel
Tribunal > TRAs/Reere Worship > SeId ¥
Town-hall > qAqe< Wage > (@A,

U War-Crime > Taloqy
Underdeveloped > S Witness > AR
Understanding > IS/ Rig=feTig Workshop > JRAE!
United front > TV Water Fall > TETe
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3. s Witwa ke afex=e— Definition.

-

| . A Wrwg - e [{eaw |

~

e bt

S. ‘Lyric’ *t%q &f$®®- [Combined 9 Banks Officer | 8. ‘Ameliorate’ & IR AfRSMAT ZCT— [Combined 7 Banks
(General)- 2022] & 1 Financial Institutions (Senior Officer)- 2021]
a) S b) 3 a) ST b) Bz e
R &Glr'zgulty. | IE tt?nt{m (Si.iv.I l-gcf?T_ [)Cc;gzbzl;]ed ¥R ¢. ‘Odd’ J? [Janata Bank Officer (Cash)- 2020]
inancial Institution (Senior Officer)-
2) 72 b) a) GRIART N DRINIEIET
C) S S d) ﬂﬁﬁ ©:c Cc) 48 7o d) ¢ < Si9) ©: a
©. ‘Agora’ ™ KA ARSEI- [Probashi Kallayan Bank | ¥- ‘Morphology’ «& Jide qmam af&s™ =t [Joint
(Officer)- 2021; Combined 6 Banks (A. Programmer)- 2021] Recritment for 2 Banks Senior Officer (IT)- 2020; Sonali &
a) <Ay b) AdgtaN= Janata Bank Officer (IT)- 2020]
¢) I d) e ®:b a) *Tog b) wfieg
Note: ‘Agora’ *Tw3 RSl SIS T | C) Irog d) sifeg ®:a
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. G */t @fb? 5. 0 O I SRR T AR Sedd S /x|
3. (9 4, g% o At KT ol Sl I ol Jt =¥ 0
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o, e 7, foq ®: ¥ F. o 4. G
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%. wa <, = . T G e
' ' 3. A 4, qE©
9. 33 9. MR T3
€. S RS = T A, 153 . &
: q S0, G ERRD =/ W2
e - Fe . Coe <, Ty
a1, ¢t q. Free ©: o '
9. TS q, A T
b, I SRR TR O X BT St <P T 38. T SRR *HETEE T O Ot 4T TR
. 72 oIl o fom et e 4. 8 oA
°1. B St . e o B . ¢ oA 7. v o o
L T e Rerem e S, TR SR TSR G PR I ~AfRre iR
F, O 3. i == F. O 2, ey
1, Alfere =1 ¥, ©Eq % ©: 5. ©&q 9. @R ©: ol
b, PR R Fefere wd ¢ i o ofey O - | yu. Qe o SR @R R iR
3. @ = . TR *1% T, AR @ 4, 2%
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¥, TP *H S I A2 0O, R ST TY-CST XHETE PR (P O (A2
T, G % ¥, faerfe T, S <, P
. FFS W% ¥, IV ¥ ©: o o, Agfre q. #ifow ‘TR
St RS ST (AT P = GG T iR @ W | 08, RO I e e )
T RIS FeaR, GPR R =T 3. OO ASARE
- (¥ W% 4, WO =% 1. G ¥ O B 4
o, ST ¥ . OE % T:o | OC W@W@W«T‘ﬁ?
5, O . TN
e T e - . it v S ®
A, 59 @y G | OY ORI (I TS *2
3. @ <, B
Q0. e @ ==fl oo =R=re o, ©8q 9, @M ©:
. S s, cotmreE 09, ‘CETE (P G e
o, (o5 q, fefe T = cfrE P
R0, O IIAG? o, ot 9, S-e™ ©: Y
T %7 AR O, SE-TH */7 @I0?
. BIN g, 3 ©: <, 9 3. 79 2, A
2. (G IRFS O W02 . o ¥, ¥ %: 9
5. O AT 05, (R NE-SS *3r?
o, qrea q, SR 9 5, I/RA 4. Ffre
Q0. ‘T * @ @R of, fareg q. goR s
F. ©GJ <, ST 80. (JIG A *=r2
o, TP q. 3af& 9 3. BifzwAt . Tl
8. ‘gF W e e @fige? o <. A T4
3. S-S 2, of 8. (MG WM %2
5. ©8q q. Oy ©: g F. Gl q, Moq
3¢, RIS B GO W02 . Q& v fefe ©: ¥
7. %% 4 R 8x. @H?ﬁﬁ%?
o, S 9. ©5q : o 3. of . T
Qv AR AT P ST (T AT TR 71, ST . Bt B
8o. (P AT I *=e?
T, S 4, TR .
. 2 . Wi B :%:T :' o
A ﬁgﬁmm#ﬁzﬁgf? 88. TNESFT (I HCHI *%?
’ ’ F. S ¥, O8]
7. CWﬁT q. W ©: P o, m q. ﬂﬂﬁi © ot
3. o @ o e . 8¢. GG Cafdt IRET *Re
5. S <, G- = Pl <. G
1. % <. B 7l o, <reTN . sfifl B o
. O (PN (T 02 8Y. “EEIRT *(B (I ST (AT WS
T S A . 9 <, P
o, A5 g v, fam T 5. f3fn 9. oF T 5
wo. A @I S (AT qPTR? 8q. ‘T MG (FIT SIA AT AS?
F. I o, & 3. AF© 2 oAffe
o1, & 9, ©&q €:q o, Tk q. IR ¥
oy, 7 @I % *=7 Twe 8. ‘(PR IV SR *?
. oo 4. 3w 5. weEIo SACIGIES
1. oM 9.4 T 5. @afA 9. of% ©:
0. (G ©BT K T2 85, ‘(FRAM @I OFIF *Rr?
5. Zrel 9. @ F. JER <. TR
o, Fom . qE ©: of 1. fRf .89 T
“Your Success Benchmark” m ﬁ.ﬂ&ﬂdﬂ




[03) Lecture 4 e oI ey BJAIN
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ex. I Reaf ==e2 Yy, ‘T = @ ORE-
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9. TS q. T o . 8¢ q. I T 9
9. TR 8 T * 726 IR Oy A= FACZ- qo. ‘geETeT =BT Tt @A

F. IR ol e <. T ol o F. JER <, TR
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3. SR 2, S T, R 2.
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9. @ 9, cIm ©: 9 . e 9. ol B o
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5. W . TR 3. ghre <, 3alS
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o, g q, o4f T3, o . 17 AT® 9. T R/ v
50, THFA *wfbq Ao 1w zem- 595. ‘Anatomy’ *THH o%-

5. T 2, Sy 3. T 9, Ted

o, SregE q. SRS R o, =R q. SR ©: o
538. ‘T W7 R7idre wd- 580. ‘Attested’ 7 IR “fFSr @AG?

3. fava <, S5 . Tojiftre 4, gejire

o, &be 7, fros ©:9 . oI 9. AF/AENA '
5C. ‘T - WA oIS 7 @12 583. ‘Archetype’ *T%g -

5. Teq1z SR 3. S <, gofs

. S°F q. 9556 ©: 4 . F o] 9. qreq 3 T
5V, foame =3 AT Radreds =7 @b 582. ‘Barren’ *It5d 9g-

5. AN 4, IR 5. T 4, T4

a1, effsfirm 7, o ©: 4 o, G . AGE ©T
534, FoFe =w Refreids == @Hi? 589. Blue Print @7 ~ffeiR® *= @HG?

3. F@req <, A 3. oAb 4, GRS

o, fotarer . TS ©: 4 o1, effofoq . el T: of
o3, TFT -7 [Reife *Fr— 588. ‘Chancellor’ &3 “ReT @HG?

3. o)y <, fSfafafs 5. AqHE <, T

o, fRow T, B 9 o, ST €, oI4TF T
535, T - oide 13- $8¢. ‘Curtail’ *t%q 7% =g @=fG?

5. TF 2, ol 5. e 4, &P

5. R . Ao ©: o . (5% A €. opd T
590, T *Twa [eifre ==r- 58, Civil Society *itw #ferr fReea @ifb?

. SETE <, S 3. ) A <, A A

o, Ao 9. IreM T3 9. RPIRE TS 9. AR TS 9
59, ‘T «F Rl - 584. ‘Cease fire’ AFeRIbT IR afS== @FHi?

5. @ 4, “fes . TG (TSI <, Sfyfadiote

. QIR q. J9y €5 . - q, 9 ACSHEFA T: o
592, TS *IHA JeifrorT *% @FHb? 58b. ‘Co-opted’ <3 ISR FIF?

. ST <. &1 3. IS 4. @ifere

3. (T g, = T o, FTifere 9, AeAifere o
JB,L, dabari m “Your Success Benchmark” ®




8.0 A ST @ SASy | ecture ( 03 §

585. ‘Constipation’ *It3a ket =- 5Y8. Scarcity-*twg IR “AfFora-
3. AR 2, FrSa @ = 7 3, gy
oA, T 9, @FRFIfT ¥ o, TFS! q, ©: o
5@o. ‘Consumer goods’ 93 TR& IR Ao It $Ue. ‘Subconscious’ *FBT IR AFSIRE = <= -
3. (SIS T 4. GO =, wéen o SRS
. TS A . (@O gelled ©: 9 o, eI 7. (oo &R %: 4
aes. Dilly dally <& o e 5>LY, ‘Superstitions’ =Twg o
. B 1 ¥, SIURY! ¥4I
o, Rl (Al <, COMTIT < B ol * T o OT%
5@2. ‘Excise duty’ @3 “fFeal- 7. FAEE . et &
= Sfefis o1 4. SR 5bq. Custom *TH3 et Rews @@=t wid?
o, SefE 6 <, wf*fe wifirg B F. > 4.
5. ‘Edition’” 3 o4- 1. &% <. AEAS ©: 4
F. HHT o, A A 5Ubr. Legal statement @3 IReT “AfForr-
o, o[@ for4e q, AFRS ®: 2 5. T3 O SACSIEEIR
5@8. ‘Filling’ *t%< IR ~AfFora- o1, 034 &f& g, wiffers e 9
<. =t 3. = 4Tt 5Ys. Gratuity =t IR AfFora-
o, Ffgle q, «fa wifee ©: o 3. N <, TR
5¢¢. ‘For Good’ &7 76 & (F1f5? 3, TSI q. 7Y ©: 49l
®. Bl 6 . g 590. Comparative *foq AT =¢=T-
o, IS v, foreta T g SN I
b(w.;sl'.lybrld’ a7 AR ‘:T-_\%B . 1. aforifre! Hp—— -
o - &g | °%- Heavenly body < et Ao @FEL?
5@q. “Justification for’ <3 AT TRV FG? . W o= . cfie®
2. sud 4 5 a1, @ffs 1o 9. o M7 9
5 TE 1. oF B3 | . Fww @G e ==
5. ‘Key-note’ 7 T #ifFrers 2 <. % 2. TTOHTEd
3. ewgd <, 5ifaIfs a1, e q. A T: 9
. TS 9. Bi=l-Baf ©: 9 | 599. Phoneme %@ =i¥-
5@5. ‘Lease’ *THT IR AFera- . WwxT <, 7Y oo
T 3. TS oA, w9 q, @ferge ©: ¥
o\, TeRl q. ST B | 58, Vivid® 0w IR PR?
SYo, TFER *[Ab @I *IH AfRerr? = Ry S
. TR <. S . frge 7, Y %«
7. R . TIFSHP <1 b 54a¢. ‘Dialect’ ¥ AT @FHbG?
5U3. ‘Prominent’ *ItHd 3% ¢ FIG?
. S 4. Srwfie <. crrer <. FT o
o1, FBIfere q, T T35 1. & St 9. BT ¥
53, ‘Postage’ *WBa AR % FHB? 59V, ‘Ab initio’ % IR “AfFSrAT Fre
T, HAAE <. TIRIRTS 3. wifgs <, Sf4zE
9. TIeRIRAl €, Gl Ty 5. SIRATER q, IS o
5L, ‘Payer’ *ITHS I ARSI 599. ‘Quack’ 97 “fFer @FHG?
3. TP <, i 3. o <, FI5a
a1, ATy 9. wre] ©: Y o, TS 9. WG ©: of

“ » Jg‘ d Is?.ﬂ.lj.
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[03) Lecture 2 e oI @ 3Ty BJA N

S, ‘RUBET G (PN S (A GETR? [Combined 5 Banks | 2. ‘B =% @H{G? [Janata Bank Ltd. AE (Teller)-2019]

Officer (Cash)- 2022] a) oA b) =&

a) tofee b) =M c) wiw d) o= T:c

¢) “refare d) Tt ©:d | do. 67 WG TSR @ 22 [Janata & Rupali Bank Ltd.
2. ‘g == @ SN (tF GR? [Combined 5 Banks Officer General-2019]

Officer (Cash)- 2022] a) o% b) fofs

a) TR b) w=if C) 514 d) pett ©:d

¢) wedlfe d) sr=fT B:d | 98. TFSIW I ©IFF =¥ [Janata & Rupali Bank Ltd. Officer
o, 5T @EG @ *13 T2 [Combined 8 Banks & Financial General-2019]

Institution Officer (General)- 2022] a) W b) a1

a) T b) c*% ¢) =R d) we=it ©:b

¢) ¢ d) i S:c | 3¢ casmf/ﬁwé-w T [Janata Bank Ltd. AEO-2019]
8. IR > > BIE 4 *FYRA P~ [Combined 7 8) b) T

Banks & 1 Financial Institution (Senior Officer)- 2022] c) CeoT=l d) & B

a) S b) v S, (PN ST 2 [Rupali Bank Ltd. SO-2019]

¢) BT d) 5T T:a a) T b) 51
¢. TR @ W SeeeT @wi® T [Probashi Kallyan ©) ¥ d) It ®:b

Bank Officer (General)- 2021] 3. (R (I O (ATF S #:¥1? [Rupali Bank Ltd. SO-19]

a) S b) <efa a) a7 b) T

¢) Gl d) af¥ ®:a c) “rgfre d) &1 S:c
L. BT (S (I ST (A GOTR? [Sonali Bank (Assistant | 07 I o 2 [Rupali Bank Ltd. SO-2019]

Database Administrator)- 2020] 3) TB, T b) fAial, srex

a) SR b) wr=fT C) AT, Bi=it d) 5, ©re ®:c

c) ofF d) “rgfore T:b | dp. ASMNE SR (AT RS @ 26 IR S S
q. T @WG G =%2 [Sonali Bank (Assistant Database PARACR?  [Probashi Kallyan Bank Ltd. EO Cash-2019]

Administrator)- 2020] a) Gf= b) TR

a) T b) = ¢) Al d) *77® T:c

c) cor d) xr® B:a | 30, fiEa PG SO ¥%? [Probashi Kallyan Bank Ltd. EO
b, ‘ﬁw (I I *? [Janata Bank Officer (Cash)- 2020] Cash-2019]

a) “ere b) fars a) 7o b) =

c) ofF d) e T d c) wfy d) e T:c
5. 907 @G GIfFRe *™ T2 [Janata Bank Officer (Cash)- | 2. G *Rtfb FrfT2[Probashi Kallyan Bank Ltd. EO General-

2020] 2019]

a) ¢ b) T a) Pt b) w&m=

C) ¥® d) T ©: b C) (AT d) e ®:c
So. ‘TP *(B R ©OEW GGR- [Sonali Bank Officer FF- | 2R. (PG ST */2  [Probashi Kallyan Bank Ltd. AP-2019]

2019] a) = b) vfeTel

a) I oA (e b) ==l ©ral (A 0) 5% d) @ T

c) f&f¥ ot et d) =T o (e Bid | qo. SO I G [Probashi Kallyan Bank Ltd. AP-
3.  RE *IHF SAIA (@G 2[Sonali Bank Officer FF-2019] 2019]

a) Aeifa b) “=S a) e b) =

c) =Ifs d) sere T:b c) & d) ST T:c
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EIGIRTE IRCRG A

28.

RE.

RV,

.

V.

RW.

Yo.

).

OR.

0O,

8.

oe.

Y,

‘5P I GFCHF *R? [Combined 4 Bank Officer General-

2019]
a) A b) &Fe

C) ©&d d) 7eFe ©: d
@G wf *=re [Sonali Bank Ltd. Officer Cash-2019]
a) Tty b) wg®

c) T d) el ©:d
(PG O *%?  [Sonali Bank Ltd. Officer Cash-2019]
a) ST b) x=

X d) R T:c
ftea @IS oo *=?[Pubali Bank Ltd. TAJO Cash-2019]
a) sm b) &=

c) ey ASIRIES T:c
@G TS *%? [Combined 2 Bank IT/ICT-2019]
)] b) o=

C) I d) Gfe ©:a
QI *=MG (@I e [Palli Sanchay Bank Ltd. ACO-
18

a) ]ETQFIT YSIEISS

¢) TR d) et T:c
o7 G e *=? [Combined 8 Bank SO-2018]
a) fam b) fawrat

c) ¥ d) L&t T:c

fbe @R T =" ANEE = T2 [Combined 5
Banks Officer (Cash)- 2022]

a) =t b) CxrRiferat

c) =r=al d) TeRRl T:c
AT %67 fS=F TW @WG? [Combined 8 Banks &

Financial Institution Officer (General)- 2022]

EVREN b) e*s

c) sife d) oy ©: d
‘S’ *twg o 2 [Combined 5 Banks Officer- 2022]
a) faw b) =R ST

C) (Pl d) =ifFs ®©:c

T *tHE =€ TET- [Combined 7 Banks & 1 Financial
Institution (Senior Officer)- 2022]

a) g b) 29

C) Fa4I| d) wfefaca= ©:b
s @ afos=fs @F=- [Combined 7 Banks & 1
Financial Institution (Senior Officer)- 2022]

a) Raxe b) B4

c) & d) A= T©:a
‘@O (@RIF- [Karmasangsthan Bank (Assistant Officer)-
2021]

a) b) @5

C) Il d) IeNRf T:a

09,

ob.

0y,

8o.

8.

8.

89.

88.

8¢.

8Y.

84.

8b.

5N 7 FALF - [Probashi Kallyan Bank Officer
(General)- 2021]

a) e b) =

c) &FIe d) SR ®:c
‘TEA *HT INELE LT [Combined 7 Banks & 1

Financial Institutions (Senior Officer)- 2021]

a) TS, T b) =3, Fifrat

c) 7, =ioat d) wf, fret T:a
eff o= - [Probashi Kallayan Bank (Officer)- 2021]

a) IEIRF b) @TF

¢) qifm d) Sn= ®©:d

TOWER 9 *twd 9 TE- [Combined 6 Banks
(Assistant Programmer)- 2021]

a) T b) cerrer

¢) AR d) = ©:b
TF AT TNLF T @AG? [Sonali Bank (Assistant
Database Administrator)- 2020]

a) oF b) fRGH

c) I d) 722 ®:c
R WwE @&~ [Janata Bank Senior Officer
(Engineering Textile)- 2020]

a) =R b) Fr=

¢) ~Ifvw d) s T:a

@HG ‘X =T FAMES % T2 [Joint Recruitment for 3
Banks Assistant Engineer (I1T)- 2020]

a) JEIRSF b) “reiy

C) S d) ooF ©:d
e @ G IdE T2 [Joint Recruitment for 3 Banks
Assistant Engineer (IT)- 2020]

a) SO - FqFIAE

b) SIS - ST (5

¢) DI - ¥ewa 4

d) ¢l (AgER - ifoet ©: d
‘@I @7 I TNLT *3 T (@IG? [Janata Bank Officer
(Cash)- 2020]

a) M= b) Jifew

c) WM d) eem ®:a
e @fS s *t3@ gt - [Bangladesh Bank Officer
General-2019]
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a) AT : Mg b) S e : Seifq@

C) 7Y : TR ) ASHENGIEY ©:b

‘R Wwq WLE 7¥-  [Rupali Bank Ltd. Officer-2019]

a) ftzes b) W+

)= d) @ T:c

Sy’ = LS - [Probashi Kallyan Bank Ltd. EO Cash-19]

a) AF b) &5

C) T d) aresfers T: d
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P03) Lecture 3 T BT '@ XSy 8 JA N K OB Prep
85. ‘OISR WA TNLF (@G? [Probashi Kallyan Bank Ltd. | v, ‘©ff'a f#ifte =%t @MfG? [Probashi Kallayan Bank

¢o.

EO General-2019]

a) S b) res

C) Iy d) & ®:d
‘ST *THF S *I3¢ (P12 [Combined 4 Bank Officer
General-2019]

Lo,

v8.

LE.

Yy,

b4,

Y.

Y.

qo.

.

Q.

Q9.

(Officer)- 2021]

a) Wik b) wfre

¢) 3fret d) e ©:b
en @ o fre *rRremg F8F TW2 [Combined 6 Banks
(Assistant Programmer)- 2021]

a) TFE-u+%E b) Tei-west

¢) SEIBH-21BiT d) srierz-fRarz ®: d
P W [eferds @ @WG? [Rupali Bank

(Assistant Network Engineer)- 2021; Janata Bank Officer
(Cash)- 2020]

a) b) aPtiEe

c) e d) &Ptie ®©:b
QA *TwR eI *3 ZCA- [Joint Recruitment for 3 Banks
Assistant Engineer (IT)- 2020]

a) = b) =Ire

C) Fe d) = ©:a
“Ugg’ =R RS *1% (@52 [Sonali & Janata Bank Officer
(IT)- 2020]

a) Gy b) ¥&

c) I d) *1s ®:c

‘% @3 eifreIde == @MG? [Janata Bank Ltd. AE
(Teller)-2019]

a) 3y b) #%<

c) iR d) feefre ©:a
‘RfE =wba [eife =13t @02  [Rupali Bank Ltd. SO-19]
a) facay b) 328

C) Fq d) wifes T:a

e Reifrords =rareaels toft =w@wR? [Rupali Bank
Ltd. Officer-2019]

a) To =¥ Qe b) 5= *= @Mt

¢) femf* == careat d) i< S AT T:b
‘Bqey @3 [RAeIdF *%-[Probashi Kallyan Bank Ltd. EO
Cash-2019; Janata Bank Ltd—2017]

a) T& b) ===

c) T & Fq1 d) ke ®©:d
W @ 918 % 2 [Probashi Kallyan Bank Ltd.
EO General-2019]

a) I b) 3=

c) e d) Ifetie T:a
‘af% @7 RoFrerds *17 @MG? [Probashi Kallyan Bank
Ltd. EO General-2019]

a) et b) siffere

¢) T d) =irafa ®:d
AN =R oS *% @? [Pubali Bank Ltd. JO-2019]
a) IS b) “rcEe

c) e d) e B d

2) Refo b) T

C) [ d) v® T:c
@. ‘7{5' @7 &ffS*3t @52 [Combined 4 Bank Officer General-

2019]

a) JqIee b) *MiieF

c) Ry d) wrifrey ®:d
@3, o *HA AL * 7 @G? [Pubali Bank Ltd. JO-19]

a) 999 b) %

C) TS d) Beofe T:a
@9, ‘I *wd HNES ¥ (FW(G? [Pubali Bank Ltd. Junior

Officer- 2019]

a) S{& b) Ta1

¢) Afere d) === ®:b
@8. fba MG T == INdF? [Pubali Bank Ltd. TAJO

Cash-2019]

a) e b) Jr=

C) o® d) sret ®: b
¢e. ‘IR *TwT INLE =% @WG?  [Combined 8 Bank SO-18]

a) Wk b) =iy

c) w7 d) fore ©:d
ey, G e ‘BEeT W AWNEF ®W-  [Bangladesh

Development Bank Ltd. Senior Officer-2017]

a) oY @ Il b) g @ Afere

C)MERA 8 fewie  d) oirify @ wwe T:d
@q. ‘=g =t%q 9% [Argani bank Ltd. Senior Officer -2017]

a) Tar b) STes

c) =i d) om T:c
e, oY «7 Aol *% @2 [Combined 8 Banks &

Financial Institution Officer (General)- 2022]

a) SEl b) ifere=!

c) w2 d) =I5 T:a
¢s. ‘R @7 Refreids w9t - [Probashi Kallyan Bank

Officer (General)- 2021]

a) Jfeww b) e

C) = d) s ®:b
vo. (I *RTEe RARreIds w2 [Combined 5 Banks (Officer)-

2021

a) Wl,{tﬁﬁﬁ%@ﬂ b) TeE-*4e

¢) sf®-af® d) =8-78 ©: d
vy, ‘TN 7 RAFedT *1% P2 [Probashi Kallayan Bank

(Senior Officer)- 2021; Probashi Kallyan Bank Ltd. EO

Cash-2019; ABL-S0O-2017]

a) X9 b) *Ke

c) B d) @ ®:c
[iadapan
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EIGIRTE IRCRG A

q8.

q¢.

Qu.

aq.

ab.

®.

bo.

bd.

bR.

bo.

b8.

be.

TR’ *HA feIRTS =7 @MG? [Pubali Bank Ltd. JO-2019]

a) SHTH b) @l
C) S d) ars T:c
fe7 @ feiTe *MTee Sw? [Pubali Bank Ltd. TAJO
Cash-2019]

a) GIa-343 b) Im-afeqm

DRISIRISACIR d) ze-fgH T:c
b @ RifTe =wee ww T®? [Pubali  Bank  Ltd.
TAJO Cash-2019]

a) Sd-mug b) ea-nfeel

¢) Tea-w4r d) SH-7Tew B:c
Tt #foq Rfte #=x @G [Pubali Bank Ltd. TAJO
Cash-2019]

a) f7=d b) S=1%

¢) WS d) ¥ ©:h
‘G @7 [Pt *137 F2[Combined 2 Bank IT/ICT-2019]
a) SPTad b) F<fre

C) FozFa d) @GR 7@ T:a
ST *eR PIATS *= @52 [Palli Sanchay Bank Ltd.
AC0-2018]

a) w4 b) S

¢) Il d) 3fe ®:b
TR *3 o o @=G? [Palli Sanchay Bank Ltd.
AC0-2018]

a) Aty b) et

¢) SRSl d) fEret ®:a
oot *=foa fIo1de *% @G2[Combined 8 Bank SO-
2018]

a) ol b) @&

c) oWl d) o/ ®:a

T w7 ReiRreIds =19-[Bangladesh Krishi Bank Ltd.
Officer Cash-2017]

a) &1 b) $1a

¢) 3= d) TegE T:a
‘Reerel” =it I91@® =¥- [Bangladesh Krishi Bank Ltd.
Officer Cash-2017]

a) e b) fifers

c) fedt d) fae ©:b
g f7IAT® *™i - [Bangladesh Krishi Bank Ltd.
Officer Cash-2017]

a) STRTI- =TT b) - CoTRT
¢) TK-=iq ) AESEEIET B:c

@G fomde =i &P =1%? [Argani bank Ltd. Senior
Officer -2017]

a) T-79 b) Ierrt
¢) SRl d) ofF-sre ®:d

b,

ba.

b,

.

So.

).

R,

9.

8.

5¢.

Y.

9.

Sbr.

“Galaxy’ *IT%d IR AFSE- [Janata Bank Officer (Cash)-

2020]
a) aR1Y b) T ife
¢) SR d) A=t ®:b

Forgery =@ JRAT Sff®m™l- [Janata Bank Ltd. AE
(Teller)-2019]

a) Fremifa b) IEeAI R

¢) wieifer d) iferzife ©:d
MR @ *Mo A Ol (}TF SIS? [Janata Bank
Ltd. AE (Teller)-2019]

a) WgA b) @ters

¢) wifd= d) eeeT<el ©:b
@M “fif¥eifd® *%? [Janata & Rupali Bank Ltd. Officer
General-2019]

a) TP b) 1=

¢) fRmfRwrrerm d) TreRaE ®:c
‘Referendum’ *®f63 JR& “HfFeifd®s Fhe [Rupali Bank
Ltd. SO-2019]

a) FCHEe b) T«rZe!
¢) fastrea d) serceit ®©:d
WIS @ REGT I [Combined 8 Bank SO-2018]

a) Polycentric b) Geocentric
c) Regiocentric d) Ethnocentric ®:a

Jingling of anklet @& IR Ft? [Combined 8 Bank SO-

2018]
a) g1 2570 b) T FTIT
C) AR Ao S d) DIt wTeT ©:b

‘Ombudsman’ €3 IR ARG - [Argani bank Ltd.
Officer Cash -2017]

a) T b) T

¢) TR d) TRREES ®:b
‘e =Twg oid- [Pubali Bank Ltd—2017]

a) b) sfrem

c) “wifes d) ~m=et T:a
T 2 [Pubali Bank Ltd—2017]

a) SCHE T b) zifes Tre

C) EE ©iF d) AreReE T T:d
TR *rrw - [Pubali Bank Ltd—2017]

a) Tea s b) &=

¢) el d) o ®:a

‘Re-g7 LT ™ T @0? [IBBL-ATO-Cash/General-

2017]
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a) e b) <t
c) =i} d) s T:a
AR *CHF ANEE =17 A2 [JBL-AEO-RC—2017]
a) e b) crefaat
c) =ity d) sem ®:C
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[03) Lecture 2 e oI @ 3Ty BJA N

ob. IR TS = (PSR [ABL-SO—2017] | 9. WiA- [Janata Bank Ltd—2017]
a) o9, 7l b) Mz, = a) weet b) w4t
C) P, TPl d) wifrey v T:a c) ey d) g = ©:a
Yoo, ‘IR *THT - [ABL-SO—2017] 8. T®- [Janata Bank Ltd—2017]
a) PR b) =t a) TN b) rafx
C) CTeseT! d)Vfl/ B:c C) ISl d) @2 7 ®:C
05, wg *wE ol [ABL-SO—2017] e, THEY- [Janata Bank Ltd—2017]
a) B b) e a) sffstay b) TorgoT
c) 5w d) =i %:d C) Sy d) @iEe 7 T:c
S03. IS o RFE ¥ [BKB-S0_2017] 5. feog @ e I ==re [BB-Officer Cash—-2016]
C) oY : =T d) 0 : AR ©:a
: SRuEY T:
¢) = 9 b 39, SRR AT *13 Z0R- [BB-Officer Cash—2016]
Y09, R FifoT o [BKB-SO—2017]
) e b) i3 a) AT b) sTm
. ' = C) IR d) Tewes ©:a
c) o d) =i © _ R IS @A AT =R T2 [BB-Officer Cash—2016]
308, (PG ST AL *3 702 [Pubali Bank Ltd—2017] a) 7, T, ST, S
a) Sy b) = b) =, 77, TreH, 9
C) oIS d) @ ®:d ¢) Tid) =, o<, T
S0¢. G A4red LT 1% T2 [Pubali Bank Ltd—2017] d) e, =, AR, iR b
a) A b) 4= 355, TSI SINET- R NI JEI- [BB-Officer Cash—2016]
c) 4ffa d) = S:c a) alfbTTel b) <z s g
Sob. (PG TNLF *1% T2 [Pubali Bank Ltd—2017] C) SHFITT OZ! d) @< e W ®:d
a) % b) & 320, OB GF TNLT *17 @FHG? [Islami Bank Ltd—2016]
¢) wom d) fifze %:b a) o b)
S09. ‘A T AfSe % 2= - [Pubali Bank Ltd—2017] c) vfert d) st ©:b
a) oM b) cemiet 3. TR od- [Islami Bank Ltd—2016]
C) g d) 3= ®:b a) @Il b) fasw
Sobr. SRS NS *7 (FB? [Pubali Bank Ltd—2017] C) PR d) wfers ©:b
a) i) b) sE= 9RR. ﬁ O *% (PINSFET? (G i Ffie-sfmi—osy]
c) feam d) wf S:b a) w1, b b) ==, eg
0%, ““ITSTET FATH TANS TG BICR I'- & I TST© ToTH C) BIF, (oI d) i, T T:c
—d [Pubali Bank Ltd—2017] S0, IR *RAMG (@ ST (A T2 [NSI-AD—2019]
a) S b) wreeE a) ¥¥ b) caf¥
¢) s d) s b ) 5 d) =t :a
Sdo. AR FNEE 7 @FFG?  [Pubali Bank Ltd—2017] 338. zﬂ' F | b © DT JIE-SFR (M) 2035
< 9
a) <B b) et 2) ) g
¢) Wi d) wafd e €) s d) e &:d
3. ‘e’ *wa od- [Pubali Bank Ltd—2017] S€. CHTTE (R >F2 [t T b s ool
2) b) <1 a) W, TS b) e, orea
' 4 + % C) 4=, Bivt d) om, ore ®:C
) &l ) e i SR, (AT (I O (ACF NS W— [ yiess Fificse-Fifeaa
3. TfrErt =R- [Pubali Bank Ltd—2017]
TR 2035]
8) eI b) s a) e b) %
C) =Rt IR @R T d) NFCHF &l ©:d DRRE d) &t ®:c
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8.0 A ST @ SASy | ecture ( 03 §

39, (I TSI *1%? [Feireht 1T Fficso-Fifem sfieTE—055] S0, O I RAIS *=7¢ @=G? [JBL-AEO-RC-2017]

a) I b) > a) ca b) wr@

c) = d) e ©:h c) wafiz d) i ®:a
33, AT e o Pz [7fr© 2 W (Answer VDP-BHBFC) | 380, Steafay »Icara ReIR® % (12 [BKB-Officer —2017]

- 20551 a) f$n b) si¢

a) TETIF b) sierwAed

) Tl d) e b €) erer d) srafe ik
335, (I ST #1312 [Sonali + Janata Bank-sifieTia (Si1E)—205s] 8. ‘:::fzoj:?g e Refre e [Pubali Bank

a) = b) o=

c; RICIEL] d; CBfet ©:a @)= b) =
S0, HF-IR1E *fo oa @ M2 =2 [Sonali +  Janata c) cofe d) st Ec

Bank ST (S1373)—2035] 383, Ty~ [Janata Bank Ltd—2017]

a) ST + FRT b) & + FRfT a) TR b) weifere

C) Mg + SRR d) @=e 7@ T:a C) SN d) g T T:a
503, B 2T (@I O (WF GEUR? [ AR FyorT | 38w, - [Janata Bank Ltd-2017]

@C—T: A:—2055] ) a) b) 5T

:;ﬁ 2; ;_?@ &2 c) TrRmI d) @R = B:c
303, TG P SR =7 [ © -5 ()05 88, 57— [Janata Bank Ltd—2017]

) 2t b) st 8) e b) erit

¢) i d) @ ®:c C) T d) @AIbE 77 ©:b
399, (PG ST */? [ © <iess ~{we T S (F7e)—2035] | 8¢ A= [Janata Bank Ltd-2017]

a) & b) e a) e b) =i

C) S&dl d) orere T:a c) e d) @R = ®:b
598, AN (@I @fAF W2 [T o UKF-ARETT () —2085] | S8Y. TR -7 fPIRS *% @FfG? [Bangladesh Bank (AD)—2017]

a) IoRD b) cfers a) I b) 3¢

C) o™ d) =fe ©:d ¢) Jfaels d) 928 ®:b
S0¢. DIAF (I SR *? [>73f7 2 1 (Answer VDP-BHBFC)- | 3gq. e =3 fRoidroids 1% Jre [PBL-SO-2016]

W%;fgf’m e a) waiaifs b) =

2%, d;ﬁ d C) SRAfre d) ST T:c
S0, G CET Wy e 3 T (Answer VDP-BHBEC) 38l “GAr-«@ f#1A *™- [Pubali Bank Junior Officer (Cash)

SFAI—2055] 2016]

2) R b) wfret a) Sierelfy b) wiewfaw

0) 5w d) 1 %d c) fem d) e B:c
S04, TS T “Iger =17 <remre e sl 51 ar—sosw] | 60 Tate =ta fReRrerds =% Fh? [Pubali Bank Officer—2016]

a) g5 b) <% a) sideife b) w=fe

c) M d) = ®:C ¢) SRS d) s S:c
sor. IR BT (AT WEFe qR eHFifTe @ TRFeF cFe@ | S¢o. e @7 Reidrords =13t @M [Bangladesh Bank Officer

JIR© *[M JAET | [F#1140 s FRGT-=fmia (Fri—205%] (General Side)-2015]

a) I b) wReRf7 a) fm b) fréa

C) W d) mevs T:a c) fat d) aerm ©: d

I/T » d bﬂ
our Success Benchmark m B!.m_ bari
® 1ddabad




[03) Lecture 4 e oI ey BJAIN

Class ¥

1 “ZS GIETS” (I (I SIFIR *7 FLCANT fd? 6. R =3 TNLE 7 (@02
a) 3G+ b) Secafe+emafa a) T4 b) G
¢) qAfe+ofF d) @A 77 ¢) Be d) e
2. o W, O 0 o I W WEE O R | 7 g wirern oo W (oI
w;ci?%wm? b) fcafirs g o) e o
a )
c) syl d) Irere 8 c) e oo @ e
3. fuos S G + R PR
2 - a) Teael b) ﬁﬁcf/
) e &) T c) emtae d) weed
4, AT GRS R o ST e 9. T efba Rofire 4 by
a) SRR b) zerfar 8) ST DA
c) TR d) @reRE ¢) Tood d) SREH
5. e g == - 10. ‘Ameliorate’ 9 JE AfTSAT =0
a) S b) el a) Sy b) S<F¥ K=
¢) FA4 d) wfef 0) g4 d) wTeTen

Answer Sheet |

ltlaf2aiAafsfDpfajcfs B[6/A[7]D[8]C[O]B[10]B]
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